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Chapter 1: Welcome to Sage
Master Builder Installation

Installation Overview

Welcome to Sage Master Builder installation

Welcome to Sage Master Builder installation. Sage Master Builder can run in
many different software and network environments. Because of that, there are
issues that you need to take into consideration for each one. The more information
you can gain about the installation process and how it relates to your software and
network environment, the more likely your installation will proceed smoothly.

To gain an understanding of what’s new about product installation:

Review the information in this book

Review the latest QuickStart Installation Guide

Read the letter from your business partner.

Learn about the licensing process. Your Sage Master Builder license is man-
aged by a the License Administration Tool and the Sage license server.

What information is in this book?

The rest of Chapter 1 “Welcome to Sage Master Builder Installation” provides
more information about customer resources, such as:
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Other printed and printable guides

The user-assistance Help system

Contacts for Customer Support

Sage Master Builder training

Information about business partners.

Chapter 2, “System Requirements and Configuration” presents technical
information about:

System requirements for servers and client workstations

Supported operating systems

Special configurations for specific operating systems

Sage Master Builder will not run correctly or not run at all on computers that do
not meet the minimum requirements, so before you install the software, be sure
your computers meet the system requirements.

Chapter 3, “Sage Master Builder Installation,” provides detailed information and
instructions for installing Sage Master Builder software in different environments,
such as:

Single user

Peer-to-peer

Network

Chapter 4, “Managing Your License with the License Administration Tool,”
provides detailed information about:

Setting the administrator password

Managing and activating your license

Sage Master Builder
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Creating group reservations

Using the License Administration Tool.

Chapter 5, “License Use and Sage Master Builder,” provides all the necessary
details about:

Specifying the Sage license server

Managing license attributes

Understanding license uses

Running Sage Master Builder in a “connected” state

Chapter 6, “Special Configurations” contains information about special
configurations for specific operating systems, such as

Windows® 7 Professional and Windows Server 2008® R2 Standard

Windows Vista® and Windows Server 2008

Windows Server 2003®

Windows XP® Professional

Citrix® and Terminal Servers

Customer Support and Resources

Before you contact Customer Support

Before you decide to contact the customer support call center, there are many
resources available to you. Our in-product Help system offers a comprehensive
library of easy to find topics. Depending on your Sage service plan, we also offer
a web-based Sage Knowledgebase and online user community forums. These

Customer Support and Resources
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services are available 24 hours a day, seven days a week. Please see below for
detailed information about all the resources available to you.

Sage Master Builder Help

You can access help about specific procedures, topics, fields, or buttons from
anywhere in the software.

Sage Knowledgebase

Our staff maintains an extensive knowledge database of questions and answers
covering everything from frequently asked questions to more complex problems
and solutions. In addition, we keep all product reference documentation available
in the Knowledgebase. This online tool is the same tool we use in our customer
support call center to help answer your call. Depending on your Sage service
plan, you can access this Knowledgebase at www.sagecre.com or through the in-
product Help menu.

To access the Technical Support Knowledgebase:

1 Click https://customers.sagenorthamerica.com/irj/portal/anonymous/login.

2 On the Welcome page, in the left column, click Knowledgebase Search to open a list of
products.

3 Complete Step 1 by selecting Sage Master Builder from the list of products.

4 Complete Step 2 by entering a search term in the box.

5 Click Search.

The search results appear below the box.

Technical Documentation Available on the Software CDs

A number of user guides are included on the software CDs we ship to you.
Important release information such as system requirements, software
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enhancements, and more can be accessed quickly and easily.

Sage Summit Customer Conference

Interact with and learn from Sage Construction and Real Estate senior leadership,
product experts, and fellow customers in one location. Get the latest information
on product updates as well as network and share experiences with your peers.
Check our website for current conference information.

Prepare to contact Customer Support

Depending on your Sage service plan, you may be able to contact the Sage
Customer Support Call Center to work with one of our highly trained, customer
support professionals. Before you call, here is a quick reference list of questions
we will often ask to help resolve your question. Prepare your answers to these
questions before calling Sage Customer Support to save you time when calling
us.

Question How to Find the Answer

What is your Sage client ID
number?

Your client ID number can be
found on correspondence you
receive from Sage. If you do
not know your Sage client ID,
please contact the person at
your company who maintains
your relationship with Sage.

What CD version are you
using?

To find the version, open Sage
Master Builder; click Help >
About Sage Master Builder
and note the number listed.

What application or area in the
software are you calling about?

On the menu list, identify the
application and number where
are you are work (i.e. Selecting
Invoices to Pay in 4-3-1,
Accounts Payable Vendor Pay-
ments).

Customer Support and Resources
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Question How to Find the Answer

How can we help you?

Walk through the exact steps
you completed with as much
detail and accuracy as pos-
sible.

Is there an error message?
Write down the exact wording
of the message.

Can you reproduce the issue?

Were you able to walk through
the same steps that led to the
problem and see whether it
happened again?

Is this the first time the problem
has happened? Does the prob-
lem occur on one workstation
or several?

Ask other users if they have
experienced the same prob-
lem. Have them test at their
workstation to see if they expe-
rience the same problem. Also,
have the original user try other
workstations to see whether
the problem is specific to that
user.

Has anything changed with
your software, hardware, or
workflow?

Ask your network administrator
for technical information
regarding anything that may
have changed behind the
scenes: upgrades to Sage
Master Builder, new third-party
software installations, moving
of data from one server to
another, new printers or print
driver installation, or anything
else that might affect the net-
work.

Does the problem happen in
the sample data sets?

Select [File> Open Company],
then change the drive letter on
the dropdown to C:, select
Sample Company.

What kind of network are you
using?

If you do not know, please con-
tact your network admin-
istrator.

Sage Master Builder
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Question How to Find the Answer

What operating system is on
your computer?

For XP: Click [Start], click
[Run], type winver and click
[OK].

For Vista: Click [Start], type
winver in the ‘start search’
window and click [OK].

What printers and print drivers
are installed?

If you do not know, please con-
tact your network admin-
istrator.

When was your last backup?
If you do not know, please con-
tact your network admin-
istrator.

Customer Support Call Responses

Our goal is to answer all calls within the first three minutes, but more often than
not we answer your call on the first ring! Once calls are answered, our support
analysts resolve over 90% of questions during the first contact. They work with
you to identify call urgency and respond accordingly. Call urgencies range from a
simple explanation of software settings to critical situations in which work is
stopped or data integrity is compromised. If a call is unable to be resolved
immediately, the support analyst will work with you based on the urgency to take
the appropriate action. Some calls may warrant further research and follow up, in
which case our support analyst will place your call in his/her in-progress work
list. At every step of the way, we work with you to until a resolution or agreement
can be reached!

Depending on your Sage Service plan, if you have an open support ticket, you
may check the status or update, or even create a new support ticket online? Just
visit www.sagecre.com and click Sage customer website under the Support
Logon. Next, select the Support tab and choose the Self Service button.

Customer Support and Resources
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You may check the status of an open support ticket, update new information
you’ve discovered on an open issue, or create a non-urgent request for help
online. Just visit www.sagecre.com and click Logon. Next, select the Support tab
and choose the Self Service button.

Contact Customer Support

Contact Customer Support in the United States and Canada at: www.sagecre.com

Sage Master Builder toll free: 800-866-8049

International: 503-690-6775

Customer Support Hours

Telephone support is available Monday through Friday from 6 a.m. to 5 p.m.
Pacific Time with the exceptions listed below. Online support incidents can be
submitted 24 hours a day, seven days a week by logging on to
https://customers.sagenorthamerica.com/irj/portal/anonymous/login. Our customer
support team will reply to your questions during normal support hours.

Every Thursday from 2 p.m. to 3 p.m. Pacific Time, closed for staff meet-
ings.

Standard United States holidays.

Quarterly company meetings.

Any additional closures will be communicated via our regular customer email
newsletters.

Sage Master Builder
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Training Resources

About training options

Learning to use Sage Master Builder software has never been easier! Whether
you choose to take online classes from Sage, participate in classroom training, or
work directly with your business partner, you will learn how to use Sage Master
Builder to support your business. Contact your business partner to find out about
training options or visit www.sageu.com/masterbuilder.

Overview of customer classes

Online classes help make learning Sage Master Builder convenient. Each
instructor has years of experience using Sage Master Builder and will lead you
step-by-step through the class material.

Online classes allow you to view the instructor’s computer screen as he or she
demonstrates Sage Master Builder software. Once you register for your class via
Sage University, you will receive email communications that tell you how to
access the training. Because the classes are live, you can ask questions and benefit
from hearing other students’ questions. Classes cover all aspects of Sage Master
Builder, including project management, estimating, scheduling, and payroll. For
more information, visit www.sageu.com/masterbuilder.

Getting started with training

All customers should begin with our New Customer Training (NCT) series,
which is included in our Essentials Training Package in recorded format for 24/7
access. These classes include an overview of the Sage Master Builder system and
its features. Customers that prefer live online training can register for the Realtime
Learning version of these NCT courses. For more information, visit:

www.sageu.com/masterbuilder

Training Resources
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Business Partners

About Business Partners

To serve you better, Sage Master Builder products and services are available to
you through an authorized network of business partners.

Your business partner is available to serve you, from simple how-to questions and
hands-on demonstrations, to installation, implementation, and training. They're
fully equipped to help you get where you want to be. For more information,
please contact your Sage Master Builder business partner.

Business Forms

Sage Construction and Real Estate Forms

Sage Master Builder is designed to work with generic checks and forms that are
available from many sources. There is no single vendor that customers must use;
however, you can get a complete portfolio of forms, tax forms, and checks
through Sage Construction and Real Estate Forms by calling 800-760-7929 or
by visiting www.sagecreforms.biz.

Sage Master Builder
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Chapter 2: System Requirements
and Configuration

Internet access recommended for Sage Master Builder

Sage Master Builder features such as printing or efiling W-2s or 1099s,
submitting enhancement requests, or downloading periodic product or tax updates
require Internet access. As we continue to update the Sage Master Builder
product, there will be additional features which will also require Internet access.
To take advantage of these features, please ensure any workstation or server that
Sage Master Builder is installed on has access to the Internet.

Hardware Requirements

About system requirements and configuration

This section provides information about system requirements along with general
and specific configuration.

More information about system requirements and configuration is available in the
Sage Master Builder Installation and License Administration Guide.

About the Sage System Verifier

The Sage System Verifier utility assists with troubleshooting hardware issues
related to the Sage licensing component. To locate the Sage System Verifier:
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Start > All Programs > Sage > Sage System Verifier.

Server hardware specifications

We cannot recommend server hardware specifications for your network, as this
depends on your specific requirements, such as the number of users on your
network, or other programs that might use server resources, such as firewalls,
software applications, mail systems, and so forth. We can, however, recommend a
set of minimum hardware requirements.

Server hardware requirements

The following table shows the operating systems that are supported for the server
computers running Sage Master Builder.

Caution!

The minimum processor requirements for servers listed in the
table below are based on the Microsoft® Windows® Server
2003® operating system family. When updating or purchasing
servers running newer operating systems such as Windows
Server 2008®, Small Business Server® 2008, and Server
2008 R2 Standard, we recommended that you also refer to
Microsoft system requirements.

Hardware Minimum Recommended

Processor Intel® Pentium® 4
or comparable

Intel® Dual Core/Quad Core™ or
comparable, 2 GHz+

RAM 2 GB 4 GB+

Free Disk Space 3.5 GB 3.5 GB+

CD-ROM Drive 2X CD-ROM 24X CD-ROM+

Printers
For highest quality printing, we recommend laser or inkjet
printers.

IMPORTANT: Theseminimum recommendations include

Sage Master Builder
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370MB of hard disk drive space required for running
Microsoft .NET Framework 3. 5 Service Pack 1 software.

Client and workstation hardware requirements

The following table shows the hardware requirements for client and workstation
computers running Sage Master Builder.

Hardware Minimum Recommended

Processor
(except
Vista/Windows
7)

Pentium 4 or compar-
able

Intel Dual Core or compar-
able

Vista/Windows 7
processor

1 GHz 2 GHz+

RAM (except
Vista/Windows
7)

1GB 2 GB+

Vista/Windows 7
workstation
RAM

2 GB 4 GB+

Free Disk Space 1 GB 3 GB+

CD-ROM Drive 2X CD-ROM 2X CD-ROM+

Printers
For highest quality printing, we recommend laser or inkjet
printers.

NOTE: These minimum recommendations include the 230 MB
required for running Microsoft .NET Framework 3.5 Service
Pack 1 software on client workstations. The recommended free
disk space is based on the installation of a single program and
the average size of a Sage Master Builder company database.
Allow at least 50 MB for each additional company database
that you create.

About system requirements and configuration
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Operating Systems Requirements

Operating systems

We recommend that the following issues be taken into account for a smooth and
successful installation experience.

Supported Operating Systems

Server, 32 and 64-bit Operating
Systems

Client/Workstation, 32 and 64-bit
Operating Systems

Microsoft Windows Server 2008®
R2 Standard

Microsoft Windows 7 Professional

Microsoft Small Business
Server 2008® Microsoft Windows Vista Business

Microsoft Windows Server 2008 Microsoft Windows XP®
Professional (SP 2 or newer)

Microsoft Windows Server 2003®

Microsoft Windows Small Business
Server 2003® (SP 1 or newer)

Sage Master Builder
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Unsupported Operating Systems

Caution!

Sage Master Builder and/or its components do not run on or do
not support some operating systems. Do not install Sage
Master Builder to computers running these Microsoft Windows
operating systems:

Microsoft Windows 95®
Microsoft Windows 98®
Microsoft Windows NT® Server

Microsoft Windows NTWorkstation

Microsoft Windows 2000®
Microsoft Windows 2000 Server®
Microsoft Windows XP Home ®
Microsoft Windows Vista Home Basic

Microsoft Windows Vista Home Premium

IMPORTANT: Microsoft .NET Framework 3.5 Service
Pack 1must be installed to all computers running Sage
Master Builder and the License Administration Tool. During
installation, Microsoft .NET Framework 3.5 Service Pack 1
is installed on your computer automatically if it is not already
installed. Be sure that all server and client computers meet
both .NET Framework requirements and SageMaster
Builder requirements.

NOTE: When you have a network with three or more users, a
dedicated file server increases performance and reliability.

Operating Systems Requirements
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Supported Microsoft Office versions

The following table shows which versions of Microsoft Office are supported in
Sage Master Builder.

Supported Microsoft Office Versions

Microsoft Office 2003

Microsoft Office 2007

Microsoft Office 2010

Web browser requirements

Web browser requirements and recommendations are:

Minimum

Microsoft Internet Explorer® 6.0, Service Pack 1 or later

Network Configuration Requirements

Server network configuration requirements

The following table shows the server network configuration requirements for
server computers running Sage Master Builder.

NOTE: Sage Master Builder typically runs in a local area
network (LAN) environment. Sage Master Builder can run in a
wide area network (WAN) using Citrix or Terminal Services.
Contact your business partner for more information.

Process Required

Network Protocol TCP/IP

Minimum Network
Speed - LAN

10/100/1000 Mbps

Sage Master Builder
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Process Required

Minimum Network
Speed - WAN

+/- 1.5 Mbps receiving data (downstream)
+/- 384 Kbps sending data (upstream)

Client and workstation network configuration

The following table shows the server network configuration requirements for
client and workstation computers running Sage Master Builder.

Process Required

Network Protocol TCP/IP

Minimum Network Speed - LAN 10/100/1000 Mbps

Minimum Network Speed -
WAN

128 Kbps Broadband

NOTE: For information about running Sage Master Builder in a
wide area network (WAN) using Citrix and Terminal Services,
contact your business partner.

About network configuration and TCP Remoting Channel

Sage Master Builder uses the TCP Remoting Channel, a Microsoft .NET
Framework component to enable communication among computers on a network.
Certain configurations can potentially disable the communication:

File sharing on computers running the Windows 7, Vista, Server 2008, and
Server 2008 R2 operating system must be enabled. To enable file sharing,
follow the instructions in the Windows 7/Vista/Server 2008 Help.

TCP communication requires the selection of port numbers that are not in
use by other processes on the local computer.

Network Configuration Requirements
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Software firewalls running on the local computer can be configured to
block processes from opening TCP ports, which will prevent com-
munication through the TCP Remoting Channel.

Configuring Sage Service Host TCP port numbers

By default, the Sage Serve Host uses the TCP port numbers 8103 and 8104.
These numbers can be configured using an XML file, Sage.SMB.xml, located
under:

\Documents and Settings\All Users\Application
Data\Sage\LS1\ServiceHost\1.1\Configuration.

If you need to change the default port numbers for the Sage Service Host using
the Sage.SMB.xml file, you must change it on every computer on the network
where Sage Master Builder is installed. In addition, after making this change, the
Sage Service Host on each computer running Sage Master Builder must be
restarted.

NOTE: Consult with your IT administrator for alternative port numbers.

To change the port numbers:

1 In Window Explorer, locate the Sage.SMB.xml under this path:
\Documents and Settings\All Users\Application
Data\Sage\LS1\ServiceHost\1.1\Configuration.

2 Right-click Sage.SMB.xml, and open it with a text editor, such as Notepad.

3 Near the end of the file between the <Remoting> </Remoting> tags, locate the port
numbers and change them.

4 Save and close the file.

5 Repeat steps 1-4 on every computer running Sage Master Builder.

Sage Master Builder
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Configuring third-party firewalls

During installation of the Sage Service Host, the Windows Firewall is configured
automatically to allow the Sage Service Host to act as a TCP server. If you use
some other firewall, however, you may need to manually adjust some settings in
the firewall in order to ensure proper operation.

You can use the following basic procedure to manually configure the Windows
Firewall to allow the Sage Service Host to communicate with other computers.
Use it as the basis for manually configuring other third-party firewall products.

To configure the Windows Firewall:

1 Click Start > Control Panel > Security Center (XP) or Security (Vista/Server 2008) or
System and Security (Windows 7).

2 Open Windows Firewall, and select the Exceptions tab (XP) or Allow a program or
feature through Windows Firewall (Vista, Windows 7, and Server 2008).

3 If Sage Service Host is not on the list, then you can add it by selecting Add Program,
then browsing to the following path:
\Program Files\Common Files\Sage\LS1\ServiceHost\1.1\Sage.LS1.ServiceHost.exe.

NOTE: By default, the exception is set to allow access by any computer on the network. If
desired, you can refine this setting by selecting the Change Scope button. Be aware that
restricting the scope incorrectly can cause the computer to be unable to connect with some or
all of the other machines on the network.

Microsoft .NET Framework 3.5 Service Pack 1

Requirements

About installation and Microsoft .NET Framework

When you install Sage Master Builder software, you will also install the Microsoft
.NET Framework 3.5 Service Pack 1, if it is not already installed. It is important
that you make sure that both your client and server computers meet the minimum

Microsoft .NET Framework 3.5 Service Pack 1 Requirements
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requirements for installing both Sage Master Builder software and Microsoft
.NET Framework 3.5 Service Pack 1.

Important:

If the Sage Master Builder installation requires an installation of
Microsoft .NET Framework 3.5 Service Pack 1, the Sage Master
Builder installation process may continue automatically after
the .NET Framework installation is completed. If you are
prompted to restart your computer after the .NET Framework
installation, however, you must do it to continue the Sage
Master Builder installation.

About installing .NET Framework 3.5 Service Pack 1 and
Operating Systems

NOTE: If Microsoft .NET Framework 3.5 Service Pack 1 is not
already installed on your computers, then that installation
alone may take up to 20 minutes per computer.

The following are the supported operating systems for .NET Framework 3.5
Service Pack 1:

Windows 7 Professional

Windows Server 2008 R2 Standard

Windows Vista Business

Windows Server 2008

Windows Server 2003

Windows XP Professional

Sage Master Builder
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Viewing and verifying system information

You may use the winmsd.exe to open the System Information window to view
a list of your system information. The winmsd.exe program is not available with
the Windows Vista Business operating system.

To view and verify system information:

1 Click [Start], the click [Run].

2 The [Run] dialog box opens.

3 In the [Open] text box, type winmsd.exe, and then press the Enter key.

The System Information window opens displaying a list of your system
information.

.NET Framework Requirements for Server Computers

Minimum requirements for Microsoft .NET Framework Service Pack 1 on
servers

Component Required

Hard disk space at installation 800 MB

Hard disk space to run 370 MB

Video card 800x600, 256 colors

.NET Requirements for Client Computers

Component Required

Hard disk space at installation 160 MB

Hard disk space to run 70 MB

Video card 800x600, 256 colors

Microsoft .NET Framework 3.5 Service Pack 1 Requirements
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Minimum requirements for the Microsoft .NET Framework 3.5 Service Pack 1
on clients

Component Required

Hard disk space at installation 160 MB

Hard disk space to run 70 MB

Video card 800x600, 256 colors

Verifying that Microsoft Internet Explorer 6.0 Service Pack 1 is installed

You must have Microsoft Internet Explorer 6.0 Service Pack 1 installed to client
computers to meet minimum requirements for running Sage Master Builder
software. This is also a requirement for Microsoft .NET Framework 3.5 Service
Pack 1.

To verify that Microsoft Internet Explorer 6.0 Service Pack 1 is installed:

1 Launch Internet Explorer.

2 On the Internet Explorer Help menu, click [About].

3 In the About Internet Explorer dialog box, verify that the version number is 6.0 Service
Pack 1 or later, and then click [OK].

Note: To download Service Pack 1 for of Microsoft Internet Explorer 6.0, visit
the following Microsoft Web site:
http://www.microsoft.com/windows/ie/ie6/downloads/critical/ie6sp1/default.mspx

Report Scheduling and Faxing Functionality

About setting up emailing and faxing through Sage Master Builder

Using the faxing functionality through the Sage Master Builder program requires:

Sage Master Builder
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Installation of the Windows operating system Fax Service component

A separate installation and setup of a fax modem in your workstation

Access to an analog phone line.

In addition, you will also have to set up the cover page information and the
number of times that the fax re-tries to send.

For more information about installing and setting up your fax modem, refer to the
documentation that came with your fax modem. Sage Master Builder does not
provide support for installing or setting up a fax modem.

For more information about installing the Window operating system Fax Service
component, see Installing the Window Fax Services component.

Upgrade to Adobe Reader version 8.1.3

Adobe Reader Version 8.1.3 supports faxing fromWindows. To fax from Sage
Master Builder, you should download and install 8.1.3 or higher.

IMPORTANT: Customers have reported problems faxing
from SageMaster Builder with versions earlier than 8.1.3.
This version is available from
http://get.adobe.com/reader/otherversions/

Disengage automatic updating for Adobe Reader

If you are using the scheduling capability for sending faxes, we recommend that
you disengage the automatic “check for updates” capability of Acrobat Reader as
it will prevent scheduled reports from completing.

NOTE: Instructions disengaging automatic “check for updates”
differ from version to version of Adobe Reader. Refer to the
Adobe Reader Help for instructions.

Report Scheduling and Faxing Functionality
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Report Scheduling and Email Functionality

IMPORTANT: Using the email capability of SageMaster
Builder requires access to a simplemail transfer protocol
(SMTP) email server. This server may be located on your
workstation PC, on a server on your company’s network, or
at your Internet service provider (ISP). If the email server is
local, youmay need the assistance of an IT professional to
properly identify or set up this capability. If the email server
is located at your ISP, youmay need contact your ISP for
assistance.

Using the ISP’s simple mail transfer protocol (SMTP) server to send email via
Sage Master Builder typically requires “user authentication” at the STMP server.
An example of an SMTP email server name is smtp.att.sbcglobal.net.

Different ISPs may use different terms when referring to user authentication. In
general, however, user authentication means verifying a user’s identity by means
of a “user name” and “password.”

In the context of sending email through Sage Master Builder using an ISP’s
SMTP server, user authentication only refers to verifying the user’s identity at the
ISP’s SMTP server. It does not refer to your:

Sage Master Builder user name and password

Network domain user name and password

Windows system user name and password.

NOTE: We do not provide support for setting up or installing an
email server. You set up user authentication and your fax line
access dial out number on 7-2 Company Information.

Sage Master Builder
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Installing the Windows Fax Services component

To fax from Sage Master Builder, you must install the Windows Fax Services
component.

To install the Window Fax Services component (XP):

1 Open the Window Control Panel.

2 On the Control Panel window, double-click Add or Remove Programs.

3 On the Add or Remove Programs window in the left column, click the Add/Remove
Windows Components icon.

4 On the Windows Components Wizard window, select the Fax Services check box, and
clear all the other check boxes.

5 Click Next, and follow the instructions on the screen.

To install the Window Fax Services component (Vista):

1 Click Start > Control Panel > Programs > Turn Windows features on or off.

2 On the Windows Features window, locate the Windows fax and scan check box, then
select it.

3 Click [OK].

To install the Window Fax Services component (Windows 7):

1 Click Start > Control Panel > Programs > Turn Windows features on or off.

2 On the Windows Features window, locate Print and Document Services, then click on
the Windows fax and scan check box.

3 Click [OK].

Report Scheduling and Faxing Functionality
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Sage Master Builder API

System requirements for Sage Master Builder API

If you are using the Sage Master Builder API, the minimum and recommended
system requirements may vary. These requirements must be considered in
addition to the recommended system requirements for running Sage Master
Builder.

It may be necessary to increase the processor speed, memory and/or disk space of
your system depending upon the requirements of the third-party application using
the API. Please consult with your third-party vendor to determine what changes,
if any, should be made to your hardware configuration in order to meet your
desired performance criteria.

Sage Master Builder
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Chapter 3: Sage Master Builder
Installation

Installation Preview

Pre-installation information for new customers

Implementing and running your business in Sage Master Builder must be
thoroughly planned out in advance to harness the power of this software. Your
existing company data must be migrated before you start working in the program.
Your business partner can assist you with a data migration and business
implementation plan. For more information about implementing Sage Master
Builder for your company, see the information about business partners in Chapter
1 of this guide.

We recommend that you take full advantage of all the knowledge and advice
found in Sage Master Builder documentation and training classes. We also
recommend that you work with your business partner and accounting
professionals before you begin to implement this software for your business.

We strongly recommend that you install the Sage license server on a computer
that is always available to other computers on your network that are running Sage
Master Builder.
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Pre-installation information for existing customers

Because existing customers are working with company information and possibly
with scheduled reports, please review these important points before you start to
install the program.

IMPORTANT: Before you install, make at least one backup
copy, but consider making two backup copies of your
existing company data for an extra margin of safety.

Duration of the installation process

Plan on at least five and possibly up to 20 minutes per computer to install Sage
Master Builder and its companion software, such as the Sample Company and the
License Administration Tool. The duration of the Sage Master Builder installation
depends a great deal upon each computer’s configuration. For example, some
newer computers are pre-installed with essential software required to run Sage
Master Builder software such as the .NET Framework 3.5 Service Pack 1.
Installation to older computers may take more time.

Additional required software

Microsoft .NET Framework 3.5 Service Pack 1 must be installed on all
computers running Sage Master Builder software. The installer determines if the
.NET Framework 3.5 Service Pack 1 is already installed. If not, the installer
installs the required software automatically.

Plan for an additional 10 to 15 minutes per computer to install .NET Framework
3.5 Service Pack 1.

NOTE: It is very important that you understand the network environments and operating
systems on the computers and server computers where you install Sage Master Builder
software. Chapter 6 Special Configurations provides detailed information about installing to
different environments.
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About installing the Sage Master Builder software to different
configurations

You can install Sage Master Builder software to many different configurations,
for example, stand-alone, network server, Citrix and Terminal Services servers,
peer-to-peer, and workstations.

IMPORTANT: The optimal operational size of a peer-to-
peer network running SageMaster Builder is two to five
workstations. Additional workstations may adversely
impact SageMaster Builder response times. Networks
consisting of more than five (5) workstations may need to
use one computer as a dedicated server.

Sage Master Builder allows users to share data and reports stored on a network
hard drive. From different workstations, users can then access the server to share
one set of data, one set of reports, and one set of report forms.

During installation, the installer checks for the components necessary to run Sage
Master Builder and then copies the program modules and reports to the \MB7
folder and subfolders that are created on the hard disk. In addition, the installation
process copies system files necessary for program operations to the Windows and
Windows System folders.

The installation process does not make any configuration changes to the
computer. After installation is complete, you must configure the stand-alone
computer, server computer, or workstation for optimal performance. For example,
you need to configure the date format on computers running the Windows Server
2003 operating system. For detailed information about configuring each server
and workstation depending on its operating system, see Chapter 6, Special
Configurations.
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Connectivity across your network

For all client workstations running the program to be connected to your company
data, they must all be connected to the Sage license sever. If one user sees the
“unable to connect” message when all other people are connected, then you know
that the connectivity problem is limited to that one person. If you encounter a
hardware failure with your server, then all the people running Sage Master
Builder will be disconnected.

License Administration Tool

Installing Sage Master Builder also installs the License Administration Tool, a
Sage licensing application. You can log on to the tool from any computer on the
network see who is using the program in “read-only” mode. In addition, the
administrator for the License Administration Tool can log on in “administrator”
mode to work with such tasks as activating your license and registering new
modules.

Option to update reports and report forms on a shared drive
during installation

If you are running Sage Master Builder in a network environment, this option
enables you to update shared system reports and report forms located on a
network drive during installation. You no longer have to run the installation
twice. When you select this option, the installation process enables a list of
network drives that already have an \MB7 folder.

IMPORTANT: This option only updates system reports and
report form files. It does not perform a complete installation.
If you need to be able to run SageMaster Builder on the
targeted server or the server’s licensing needs to be
updated, youmust do a complete installation directly on the
server.

Sage Master Builder
30 Chapter 3



Installing the Sample Company

The Sample Company provides the means for viewing and working with sample
data in Sage Master Builder windows. There are sample accounts, sample
employees, sample takeoffs, and much more. By viewing and working with this
sample data, you can gain an understanding of how different windows interact
with the sample data when managing a construction business with Sage Master
Builder.

Sage Master Builder master trainers use the Sample Company extensively during
Sage Master Builder training classes. We highly recommend that you load the
Sample Company during your initial installation.

You can log on to the Sample Company using “Supervisor” as the user name.
You do not need a password.

The Sample Company:

Allows you a safe way to try out new functions as you learn them.

Is used in many on-line and recorded classes.

Provides samples of many Sage Master Builder forms that are all filled in.
This makes it easy to understand many concepts.

Provides starter lists for many values you'll need to set up: cost codes, cost
types, tasks, client status, client type, employee positions, paygroups, etc.

Provides you with live data to investigate the content of Sage Master
Builder reports.

Takes very little space on your hard disk drive.

Installing the Sample Company overwrites any previous installations of the
Sample Company. If you have made changes in your Sample Company that you
wish to keep, rename this folder before installing a fresh copy of the Sample
Company.
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New Installations

About new installations

A new installation is defined as:

Installing the software on a computer that has never had Sage Master
Builder installed on it before.

Installing the software on a computer where Sage Master Builder and Sage
Licensing has been removed using Control Panel > Add or Remove Pro-
grams.

NOTE: Instructions for reinstallation/upgrade installation over an existing installation are
different. See Upgrade Pre-installation.

You must designate one computer on your network as the Sage license server.
This server will manage use of Sage Master Builder; for example, the number of
people who can use Sage Master Builder simultaneously on your network. You
will need to install the software on this computer first and then activate your
licenses before installing Sage Master Builder on your other computers.

The installation package of files is the same whether it is available to you on a CD
or in a folder on a network drive.

There are two ways to install the program:

You can install Sage Master Builder from the product CD at each com-
puter.

You can copy the entire CD (all files and folder) to a folder that you create
on a network drive and then install to each client workstation by launching
the installation from that network folder from that client workstation.
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No matter which installation method you use, we recommend that you install to
the Sage license server computer first. Then when you install the program to your
workstations, you can set up Sage Master Builder to find the Sage license server
and run the program using your license.

The installation process also presents different installation windows depending on
whether you are installing the Sage license server and Sage Master Builder or you
are just installing Sage Master Builder by itself.

Basic steps for new installations are:

1 First install the program on your network server, the computer where all your company
data is located. You do this only once on your network. Remember to write down the
Sage license server computer’s IP Address and/or computer name, which is displayed at
the end of the installation.

2 Next, activate your license.

3 Install the program to all client workstations on your network.

4 From each client workstation, specify the Sage license server.

IMPORTANT: Always start installing the program at the computer that will be your Sage
license server, which is likely to be your network server.
Installing Sage Master Builder on client workstations

Find your installation method below, either CD or network folder, and follow the
installation instructions.

To install Sage Master Builder only from a CD:

1 Close all open programs except for firewall and antivirus programs.

2 Insert the Sage Master Builder CD into your CD-ROM drive.

3 If the install program does not start automatically, go to Start > Run > Browse, locate
your CD drive and select setup.exe. Then click [OK].

4 Read the instructions on the installation welcome window, and click [Next].

5 On the installation option window, select the option This computer will run Sage Master
Builder only, and click [Next].

New Installations
 Chapter 3 33



6 On the license agreement window, read the License Agreement carefully.

7 Select the check box to accept the terms, then click [Next]to continue the installation.

8 The select a drive window appears.

9 Select a local drive location for the installation, and click [Next].

The installer begins the installation process. It checks to see if the computer has
.NET Framework 3.5 Service Pack 1 installed. If this program is not found, the
installer installs it.

On the select additional options window:

a Install the Sample Company for training purposes. We recommend that you install the
Sample Company.

b Update reports and report forms on a local or network drive. This does not install the
entire Sage Master Builder program on the other drive. It only updates the system
reports and report forms.

NOTE: This option may not appear for first-time installations because it is unlikely that a shared
\MB7 folder already exists on your network.

The installer begins the installation process. It checks to see if the computer has
.NET Framework 3.5 Service Pack 1 installed. If this program is not found, the
installer installs it.

NOTE: If the install program does not start automatically, go to Start > Run > Browse. Locate
your CD drive or CD image folder, select setup.exe, and then click [OK]. If your computer
security warns you that Sage Licensing is trying to access the Internet, click [Allow].

An installation complete window appears. The Launch Sage Master Builder
check box is preselected so that you can launch Sage Master Builder and specify
the Sage license server.

Read the important message and follow the instructions to launch Sage Master
Builder.

Click [Finish].
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Master Builder begins its launch process by displaying the Specify Sage License
Server window.

For more information about this process, you can click the Help button on the
Specify Sage License Server, or see Chapter 5 License Use and Sage Master
Builder.

To install Sage Master Builder only from a CD image in a network folder:

1 Close all open programs except for firewall and anti-virus programs.

2 On a network drive, create a folder named, for example, Master Builder 16 CD Image.

3 Copy the entire contents of the CD (all files and folders) to that folder.

4 In the folder that you have created, locate the setup.exe file and double-click it.

5 Read the instructions on the installation welcome window, and click [Next].

6 On the installation option window, select the option This computer will run Sage Master
Builder only, and click [Next].

7 On the license agreement window, read the License Agreement carefully.

8 Select the check box to accept the terms, then click [Next]to continue the installation.

9 The select a drive window appears.

Select a local drive location for the installation, and click [Next].

The installer begins the installation process. It checks to see if the computer has
.NET Framework 3.5 Service Pack 1. If this program is not found, the installer
installs it.

On the select additional options window:

a Install the Sample Company for training purposes. We recommend that you install the
Sample Company.

b Update reports and report forms on a local or network drive. This does not install the
entire Sage Master Builder program on the other drive. It only updates the system
reports and report forms.
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NOTE: If the install program does not start automatically, go to Start > Run > Browse. Locate
your CD drive or CD image folder, select setup.exe, and then click OK. If your computer security
warns you that Sage Licensing is trying to access the Internet, click Allow.

An installation complete window appears. The Launch Sage Master Builder
check box is preselected so that you can launch Sage Master Builder and specify
the Sage license server.

Read the important message and follow the instructions to launch Sage Master
Builder.

Click [Finish].

Master Builder begins its launch process by displaying the Specify Sage License
Server window.

Upgrade Installations

About upgrading Sage Master Builder

If you currently have Sage Master Builder installed on your network computers
and you are going to reinstall it, you could be either upgrading or updating the
software.

Upgrade installations involve major changes, enhancements, and fixes to many
parts of the program or to modules such as licensing. For example, installing
Version 15 over Version 14 is an upgrade installation because there are major
enhancements to the program.

Update installations, in contrast, usually involve changes to specific files, such as
the Sage.SMB.PayrollTax.dll file and report forms. These files can be changed
and updated without any changes to major parts of the program.

In addition, upgrade installations are different from a new installations.
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During a new installation (or reinstallation after completely removing Sage
Master Builder and Sage licensing), you can designate a computer to be
either the Sage license server or a client work station.

During an upgrade installation, the installer checks to see if Sage licensing
exists on that computer. If the installer detects a previous installation, the
installer follows the prior installation path for that computer. You do not see
the option to select a designation. If a computer had previously been the
Sage license server, it will be reinstalled/upgraded again as the Sage license
server.

NOTE: If you want to change a computer’s designation as
either a Sage license server or a client workstation, you need
to uninstall the Sage licensing and the Sage Master Builder
program using Control Panel > Add or Remove Programs.

Upgrade Pre-installation

Upgrade pre-installation tasks

Upgrading your Sage Master Builder software requires that you complete
preliminary tasks to ensure the safety of your company data.

When upgrading, it is important that you choose a block of time when you can
install the upgrade to all the computers in your office beginning with your Sage
license server computer. Depending on your computer’s hardware and your
network configuration, plan on 15 minutes per computer for the installation
process alone. Additional tasks may take extra time.

The following are steps to take before upgrading Sage Master Builder:

1 Make two backups of your company data. We suggest making two backups in case one of
them is incomplete, becomes corrupted, or is lost.
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2 Exit Sage Master Builder and all other programs - You must not install the Sage Master
Builder upgrade when either Sage Master Builder or the Sage Master Builder API are
running. We recommend that you shut down all other programs when installing Sage
Master Builder, but you do not have to shut down firewall and anti-virus software.

3 Locate the computer on your network that is your Sage license server, and begin the
upgrade installation there.

Upgrade Installation

About installing the upgrade

Always begin all installations at the computer that is the Sage license server. After
installing the upgrade to the Sage license server, install the upgrade to your
workstations from the image placed in a folder on the network.

Sage Master Builder running on client workstations needs to connect to the Sage
license server to access your company data. If you do not change the designation
of any computers on your network during an upgrade installation, all client
workstations will be able to locate the existing Sage license server again after
installation.

In addition to installing the Sample Company, you may have the option to update
system reports and report forms on a local or network drive. For example, let’s
suppose that your system reports and report forms are located on a shared drive M
under an existing \MB7 folder. Now during Sage Master Builder installation to
drive C on your local computer, you can also update system reports and report
forms to shared drive M.

This option is only available if an \MB7 folder already exists on a different local
or network drive. Updating system reports and report forms on different drive
does not install the Sage Master Builder program. For example, if you want to
install Sage Master Builder to a network drive, you have to go to that computer
and install the program from there.

NOTE: You only need to update your system reports and
report form once on the shared drive from one computer on
your network.
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Resetting the Sage license server computer

In certain instances, you may encounter a Sage license server identification issue.
After installing the upgrade, Sage Master Builder should automatically identify
the same license server computer as it did before the upgrade.

IMPORTANT: When launching SageMaster Builder on a workstation and you see the
message, “Unable to find license server,” you can reset the license server computer with a
few steps.

To reset the license server computer:

1 On a different computer running Sage Master Builder connected to the Sage license server,
launch Sage Master Builder, and then click File > Change Sage License Server.

2 On the Change Sage License Server window, look at the first line, and write down the
Sage license server IP address. An IP Address is a series of numbers that identifies the
computer on a network, for example, 10.227.16.40.

3 Go back to the computer that cannot find the Sage license server, launch Sage Master
Builder, and then click File > Change Sage License Server.

4 On the Change Sage License Server window, select the second option, Enter the IP
Address or name of the computer, and follow the instructions on the window.

If you need more information, refer to the Help topic, “Changing the Sage license
server.”

Upgrade Post-installation

Upgrade post-installation tasks

Once you have completed your upgrade installation, perform the following task:

1 Launch your company and rebuild indexes - Before you can work in the Sage Master
Builder company data, you have to rebuild the indexes of each company in which you do
work. This process upgrades the company databases to the new version.
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For instructions, open the Sage Master Builder Help and search using the Help
search shortcut term “indexdatabase.”

IMPORTANT: You only have to rebuild the indexes for each company’s database one
time from one computer using 7-4 Rebuild Indexes.
Change Sage License Server Designation

About reinstalling to change the Sage License Server designation

If you want to change a computer designation from client workstation to Sage
license server or vice versa, you must first uninstall the Sage License. Use
Control Panel > Add or Remove Programs to uninstall the Sage License, then
reinstall the Sage Master Builder program. This approach produces the equivalent
of a new installation.

If you reinstall Sage Master Builder over an existing installation, the installation
process reinstalls the program to the designation selected in the initial installation.
Therefore, after reinstallation, a Sage license server computer remains a Sage
license server and a client workstation remains a client workstation.

NOTE: Simply reinstalling Sage Master Builder on a computer that is the Sage license server
does not affect your license settings or reinstall the License Administration Tool.

To change a computer designation by reinstalling (changing a workstation
computer into the Sage license server or the Sage license server into a work-
station):

1 Uninstall Sage Licensing from the Control Panel > Add or Remove Programs.

2 Reinstall Sage Master Builder following the instructions for new installations.

Information about new installations is in chapter 3, “Sage Master Builder
Installation,” in the subsection, “New Installations.”
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Add a New Server

Adding a new server to your network

If you buy a new server to add to your network and you want to reinstall your old
server as a client workstation, follow the steps below.

To add a new server to your network:

1 First uninstall Sage Licensing and Sage Master Builder from your current server using
Control Panel > Add or Remove Programs.

2 Then install Sage Master Builder to the new server with the designation as Sage license
server. Don’t forget to write down the Sage license server computer’s IP Address and
computer name.

3 Activate your license and perform other Sage license server tasks.

4 Go to each client workstation, and specify the new Sage license server. Make sure that
each client workstation can find and connect to the Sage license server.

5 Install Sage Master Builder on the computer that was the old server and specify the new
Sage license server. Make sure that the client workstation can find and connect to the
Sage license server.
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Chapter 4: Managing Your License
with the License Administration

Tool

The License Administration Tool

About the License Administration Tool for Sage Master Builder

When you purchase Sage Master Builder software, it includes the License
Administration Tool. Using the License Administration Tool, you can import
license files, activate licenses, reserve the use of products and features, and
monitor the use of products and features. This tool also supports site licenses and
floating use licenses. During software installation, the License Administration
Tool is automatically installed on the computer that the software installer
designates as the Sage license server.

IMPORTANT: Before you can use SageMaster Builder
with your activated license, you have to specify the
computer on your network that is the Sage license server
when you launch SageMaster Builder.

Where is the Sage license server located?

The Sage license server is software running on a computer on your network that
manages the Sage Master Builder products and features that you purchased.
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Products and features can be a “core product,” additional “modules,” and a
number of “license uses.” The computers running your Sage Master Builder have
to be connected to the computer running the Sage license server so that the correct
products, features, and number of license uses are available to you.

License Administration Tool Logon

About accessing the License Administration Tool

You use the License Administration Tool for two purposes:

To activate and manage your Sage Master Builder product license, you
must log on to the License Administration Tool in administration mode. At
the first launch of the tool, you can set the administration password. Use
administration mode to add and update the product licenses, change the
password, set up License Groups and license use reservations.

To view who on your network is using Sage Master Builder, open the
License Administration Tool read-only mode.

IMPORTANT: Before you can log on andmanage the
license using the License Administration Tool from a client
workstation, the \MB7 folder must be shared on the
computer that is the Sage license server. For information
about sharing folders, see theMicrosoft Windows Help.

When you launch the License Administration Tool, the program displays the
License Administration Tool Logon window. This window offers two options:

Open the License Administration Tool in read-only mode. Use this mode to
determine who is using Sage Master Builder. For example, you need to use
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Sage Master Builder for a task that requires exclusive access. When you
open the tool in read-only mode, you can see who is using the program.

Open the License Administration Tool in administration mode. Use this
mode to manage, add, or remove license uses or to register new modules.
The first time you open the License Administration tool, you must set the
password. Selecting this option, displays a box or boxes for setting your
password and two links, I forgot my password and Change password.
Clicking either of these links launches other windows which enable you
either to change or reset the administration password. We strongly rec-
ommend that you write down your the License Administration Tool pass-
word and save it in a safe place. If you forget your password, you have to
call Sage Customer Support to reset it.

Logging on with read-only mode
1 Double-click the LA desktop icon.

2 On the License Administration Tool Logon window, accept the option, Open the License
Administration Tool in read-only mode. For example, use read-only mode to determine
who is using Sage Master Builder.

3 Click [OK], then click [OK] on the message window.

4 The License Administration Tool opens in read-only mode.
Logging on with administration mode
1 Double-click the LA desktop icon.

2 On the License Administration Tool Logon window, select the option, Open the License
Administration Tool in administration mode. For example, use this mode to add or
remove license uses or to register new modules.

3 In the Password box, type your password.

NOTE: Your License Administration Tool password is case-sensitive.
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4 Click [OK], then click [OK] on the message window.

5 The License Administration Tool opens in administration mode.
Setting the password

IMPORTANT: We strongly recommend that you write down your administrator user
password and save it in a safe place. If you forget your password, you have to call Sage
Customer Support to reset it.

After the License Administration Tool has been successfully installed, clicking
the License Administration Tool desktop icon opens the License Administration
Tool Logon window. Before the Administrator can log on and manage the
license using the License Administration Tool from a client workstation
computer, the \MB7 folder must be shared on the computer is the Sage license
server. For information about sharing folders, see the Windows Help.

To set the administrator user password:

1 In the Password box, type a password.

NOTE: Your License Administration Tool password is case-sensitive.

2 In the Confirm Password box, re-type the password and click [OK].

3 The License Administration Tool window opens. From this window you can manage your
product license, license groups, and license use reservations.

Changing the password

IMPORTANT: We strongly recommend that you write down your administrator user
password and save it in a safe place. If you forget your password, you have to call Sage
Customer Support to reset it.

To change the administration password:

1 Double-click the LA desktop icon.

2 On the License Administration Tool Logon window, select the option, Open the License
Administration Tool in administration mode. For example, use this mode to add or
remove license uses or to register new modules.

3 Click the text link, Change my password.
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4 On the Change Password window in the Old Password box, type your old password.

5 In the Password box, type a new password.

6 In the Confirm Password box, type a new password again, and click [OK].

7 The License Administration Tool window opens.

From this window you can manage your product license, license groups, and
license use reservations. Before the Administrator can log on and manage the
license using the License Administration Tool from a client workstation
computer, the \MB7 folder must be shared on the computer is the Sage license
server. For information about sharing folders, see the Windows Help.

Resetting the password

To reset the administrator user password, you have to contact Sage Customer
Support.

IMPORTANT: Before the Administrator can log on andmanage the license using the
License Administration Tool from a client workstation computer, the \MB7 folder must be
shared on the computer that is the Sage license server. For information about sharing
folders, see theWindows Help.

To reset the administrator user password:

1 On the Logon Administrator Password window, click I forgot my password.

2 The Forgotten Password window opens.

3 Read the instructions, phone Sage Customer Support at 800-866-8049, and type the
temporary password they provide in the box.

4 You can also ask Sage Customer Support to send you the temporary password in an email
message. From that message, you can copy and paste the temporary password into the
Forgotten Password box.

IMPORTANT: Type the temporary password exactly as provided by Sage Customer
Support. Passwords are case-sensitive.

5 Click [OK].
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6 The Change Password window opens. The temporary password is now displayed in the
Old Password box. The temporary password acts as your old password and allows you to
set a new password.

7 In the New Password box, type a new password.

8 In the Confirm Password box, re-type the new password and click [OK].

9 The License Administration Tool window opens. From this window you can manage your
product license, license groups, and license use reservations.

Monitoring Product and Feature Use

About monitoring product and feature use

After activating licenses and reserving the use of Sage Master Builder, you can
monitor the license use and group reservations from the License Administration
Tool window.

Tip: The terms you see in this topic, such as Status, License
Type, and so forth are defined in the Glossary under License
Administration Tool.

When you select a Floating use License Type with reservations in the License
Administration Tool window, the window displays the following grids:

License details for product line

Summary of product or feature use

Current users of the product or feature

When you select a Floating use License Type without reservations, the window
displays the license details Current users of the product or feature grid.

When you select a Site License Type, the window displays the license details grid
and definitions for the Product Line, Product or Feature, and License Type.
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NOTE: If you have not added licenses, the grids on the
License Administration Tool window are empty.

License details for product line

After you add licenses, the license details grid displays the following information
for the product line:

Status

Product Line (Hidden by default. To display, right-click a column heading
in the grid and selectHide/Show Columns > Product Line.)

Product or Feature

Reservations Allowed (Hidden by default. To display, right-click a column
heading in the grid and selectHide/Show Columns > Reservations
Allowed.)

License Type

Total Uses

Available Uses

In Use

Expiration Date

Version

Summary of product or feature use

After you reserve the use of products and features for a floating use license, the
Summary of product or feature use grid displays the following information for the
license that you select in the license details grid.
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Reserved For

Total

Available

In Use

Current users of the product or feature

After you activate floating use licenses, the Current users of the product or feature
grid displays the following information for the license that you select in the
license details grid.

User Name

Reserved Under

Computer Name

Session ID

In Use Since

Show and Hide Column Features

About showing or hiding columns

Use the Show/Hide Columns window to select the columns that you want to
display in the license details grid on the License Administration Tool window.

Showing columns

To monitor license use, you may choose to show columns.

To show columns:

1 From the License Administration Tool window, right-click a column heading in the
license details grid and select Hide/Show Columns.
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2 From the Show/Hide Columns window, select the columns that you want to display or
click Show All.

3 Click [OK].

Hiding columns

You may want to hide one or several columns for business security reasons.

To hide a column:

1 From the License Administration Tool window in the license details grid, right-click the
column heading that you want to hide.

2 Select Hide Column.

Hiding all columns

You may want to hide all the columns for business security reasons.

NOTE: You cannot hide the Product or Feature column.

To hide all columns

1 From the License Administration Tool window, right-click a column heading in the
license details grid and select Hide/Show Columns.

2 From the Show/Hide Columns window, click [Hide All].

3 Click [OK].

Managing Licenses

About managing licenses

Use the Manage Licenses window to add product keys, update product keys, and
activate licenses.
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Importing the license file

Use the Import License File window to import a license file into the Sage license
server.

License activation is based on either importing a license file or manual entry of up
to four product keys. Take a moment to locate your product keys. They are a
series of 16-letter codes used to activate your license. They have been sent to you
in a license file attached to an email from your business partner, on your Sage
Master Builder packing slip, and/or on a sticker on the CD envelope.

NOTE: If you did not receive a license file in an email message, follow the instructions for
adding or updating product keys.

To import the license file:

1 Open the email message with the attached license file from Sage or your business partner.

2 Save the license file attachment to the Windows desktop.

3 From the License Administration Tool window, click [Manage Licenses].

4 From the Manage Licenses window, click [import the license file].

5 From the Import License File window, select the license (.lic) file name and click [Open].

6 From the Manage Licenses window, click [activate the licenses].

7 Click [Close].
Adding or updating product keys

Use the Add or Update Product Keys window to type the product keys. Each
time you add or make changes to licenses, you will receive new product keys.

License activation is based on either importing a license file or manual entry of up
to four product keys. Take a moment to locate your product keys. They are a
series of 16-letter codes used to activate your license. They have been sent to you
in a license file attached to an email from your business partner, on your Sage
Master Builder packing slip, and/or on a sticker on the CD envelope.
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NOTE: If you received an email message with an attached license file from Sage, follow the
instructions for importing the license file.

To add or update product keys:

From the Manage Licenses window, click [type the product keys].

1 In the Type the product keys boxes on the Add or Update Product Keys window, type the
product keys listed on your CD envelope or that are printed on your packing slip.

2 On the Add or Update Product Keys window, click [Accept Product Keys].

3 Click [Accept Product Keys].

4 On the Manage Licenses window, click [Activate the licenses].

5 Click [Close].
Activating licenses

After importing the license file or entering product keys, you have to activate your
licenses.

To activate your license:

1 On the Manage Licenses window, either import the license file or add the product keys.

2 Click [Activate the licenses].

3 Click [Close].

When you see two green check marks by Step 1 and Step 2, you know that your
license has been activated. You can now launch the License Administration Tool
and specify the computer on your network that is the Sage license server.

Managing Reservations

About managing group reservations

Use the Group and Uses columns on the Manage Reservations window to reserve
product and feature uses for groups.
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When a user logs in to a Sage Master Builder company, the Sage license server
assigns a license use from the first available group to which the user belongs. If
no reserved license uses are available, the Sage license server assigns a license
use from the unreserved license uses.

IMPORTANT: If no reserved or unreserved license uses
are available, you cannot launch SageMaster Builder
connected. You can only launch the program disconnected
with exclusive access.

Setting up group reservations

Use the Group and User columns on the Manage Reservations window to reserve
license uses for groups.

When a user logs in to a Sage Master Builder company, the Sage license server
assigns a license use from the first available group to which the user belongs. If
no group reservations are available, the Sage license server assigns a license use
from the unreserved uses.

IMPORTANT: Youmust import the license file or enter product keys before you set up
group reservations.

To set up group reservations:

1 From the License Administration Tool window, click [Manage Reservations].

The Manage Reservations window for this product line opens.

2 >In the Group column, type the name of the first group of users.

3 You can assign any group name that works for your purposes.

4 In the Uses column, type the number of license uses that you want to reserve for this
group.

IMPORTANT: The total number of Uses for all groups cannot exceed the Total Uses
listed for this product on the License Administration Tool window.

5 Repeat steps 2 and 3 for each group.
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Tip: If you want to retain some unreserved license uses, do not reserve all license
uses for groups.

6 Click [OK].
Removing group reservations

You may need to create new reservation groups when you hire new employees or
open a new office.

To remove group reservations:

1 From the License Administration Tool window, click [Manage Reservations].

2 From the Management Reservations window, select the row for the Group that you want
to remove.

3 Click the [Delete the selected row] (the X button).

4 Click [OK].

Troubleshooting Network Disconnect Issues

Disconnected from the network

NOTE: This information does not apply if you are running Sage Master Builder and the Sage
license server on one computer as a stand-alone installation.

If a workstation is disconnected from the Sage license server while you are using
the License Administration Tool, the system displays a Disconnected from the
License Server message.

Since our products run on your company's network, it is important to maintain the
network connection between workstations and the Sage license server. When
your workstation is disconnected from the Sage license server, you cannot
perform license administration functions using the License Administration Tool
on the workstation.
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To reconnect to the license server:

1 Wait a few minutes, and then try again to use the License Administration Tool.

2 If the workstation is still disconnected, check whether the network cable is unplugged.

3 If the workstation remains disconnected, check whether a network drive is disconnected.

4 Contact your network administrator.

When the connection is restored, the License Administration Tool returns to
normal and you can perform any of its functions.

Network cable unplugged

When the network cable is unplugged from your workstation, you cannot perform
license administration functions using the License Administration Tool.

To check whether a network cable is unplugged:

1 Check the notification area, at the far right of the taskbar, for this message: A network
cable is unplugged.

2 If you see this message, reconnect the network cable to the workstation.

3 If you do not see this message, check the network connections.

a Click [Start], and select Control Panel > Network Connections.

b In the LAN or High-Speed Internet section, check the Status of the Local Area
Connection.

c If the Status is Network cable unplugged, reconnect the network cable to the
workstation.

d If the Status is Connected, the network cable is connected to the workstation.

4 Try to use the License Administration Tool.
Disconnected network drive

When your workstation is disconnected from the network drive for the Sage
license server, you cannot perform license administration functions using the
License Administration Tool.
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To check whether a network drive is disconnected:

1 Click [Start], and select My Computer.

2 In the Network Drives section, check the Type column for the network drive for the Sage
license server.

3 If the Type is Disconnected Network Drive, select the network drive and then select
another network drive.

4 If the Type changes to Network Drive, try to use the License Administration Tool.

5 If the Type remains Disconnected Network Drive, contact your network administrator.
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Chapter 5: License Use and Sage
Master Builder

Specify Sage License Server

About specifying the Sage License Server

Before you can use Sage Master Builder with your activated license, you have to
specify the computer on your network that is the Sage license server. There are
two ways to specify the Sage license server:

You can select the computer from the list of computers on your network; or

You can enter the IP Address or name of the computer.

Selecting the Sage license server computer

One method is to select the computer running the Sage license server from the list
of network computers.

NOTE: To use this method of selecting a server from the list of network computers, you must
have already clicked the appropriate link on the Specify Sage License Server window.

To select the computer running Sage license server from the list of network
computers:

1 On the Select License Server window from the list of network computers, select the
computer running the Sage license server.

2 Click [OK].
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Entering the IP Address or name of the computer

One method is to enter the IP Address or name of the computer running the Sage
license server.

NOTE: To use this method of selecting a server from the list of network computers, you have
already clicked the appropriate link on the Specify Sage License Server window.

To enter the IP Address or name of the computer running the Sage license
server:

1 In the text box, type the IP Address or name of the computer.

2 Click [OK].
Determining the name of a computer

NOTE: If you are trying to determine the name of the computer running the Sage license server,
you must complete this procedure on that computer.

To determine the name of a computer:

1 Click Start > Settings > Control Panel.

2 From the list, scroll to and double-click System.

3 The System Properties window appears.

4 Locate the line Full computer name, and write it down or type it into a note that you can
print.

5 Click [Cancel].
Determining the IP Address of a computer

NOTE: If you are trying to determine the IP Address computer running the Sage license server,
you must complete this procedure on that computer.

To determine the IP Address of a computer:

1 Click Start > Run.

2 In the Open text box, type cmd, then click [OK].

3 The \Windows\...\cmd.exe window appears.

4 At the prompt, type ipconfig.
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5 For example, you might see H:\. Type ipconfig after the drive letter. When you press the
Enter key, the system displays several addresses, among which is the IP Address of the
computer. You see a line similar to this:

IP Address . . . . . . . .172.20.22.142

What is an IP Address?

Every computer connected to the Internet is assigned a unique number known as
an Internet Protocol (IP) address. This numeric address of a computer on the
Internet is written as a set of four numbers separated by periods (each number can
range from 0 to 255). An example of an IP Address is 123.123.4.5.

NOTE: If you are trying to determine the IP Address of the
computer running the Sage license server, you must complete
the procedure on that computer.

What is a server?

There are many kinds of servers. Some servers are denoted by their hardware
configuration and a specialized operating system. Other servers consist of
specialized software applications running on standard computers.

Some servers are called “file servers” and may be a powerful computer dedicated
to storing files and data. For example, Sage Master Builder company data can be
stored on a file server. Any Sage Master Builder user on the same network as the
file server can access and store data there.

A server can also be a software application that provides a specific kind of service
to client software running on other computers. The term server can refer to a
particular piece of software, such as the Sage license server. When we refer to the
Sage license server, we are describing a computer that is running the Sage license
server software.
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Running Sage Master Builder Connected

Launching and running Sage Master Builder connected

NOTE: If you are having a problem running Sage Master Builder connected, it is very likely a
network problem or your computer’s connectivity to your network. If problems persist, consult
with your local system administrator.

The desired Sage License Server Connection State is:

Connected: License use acquired. This connection state allows you to use all
the power of the Sage Master Builder product that you purchased and licensed.
Running connectedconnected means that your computer is connected to the Sage
license server, and there is a license use available to you.

Prerequisites for a launching and running connected include:

An activated Sage Master Builder product license. The administrator user
activates the product license using the functions of the License Admin-
istration Tool.

A network connection, if you are on a network. This only pertains to work-
ing in a network environment and does not pertain to a single computer run-
ning in a stand-alone environment.

The Sage license server that has been specified from the computer running
Sage Master Builder.

An available license use.

Being a user and having access to a Sage Master Builder company.

To launch and run Sage Master Builder connected:

1 Double-click the Sage Master Builder desktop icon.

2 The Specify Sage License Server window appears.
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3 Choose one of the following:

a Select the Sage license server from the list of computer on your network.

b Enter an IP Address or name of the computer that is the Sage license server.

4 When you have satisfied the conditions to specify the Sage license server, click [OK].

5 Sage Master Builder begins its launch process.

6 On the Company List window, select a company, or click [Cancel].

7 From the Company List window, select a company.

8 On the User Name and Password window, enter your user name and password.

9 Sage Master Builder opens the company.

You are now running Sage Master Builder connected.

About the Sage License Server Connection states

You can view the current connection state to the Sage license server in the About
Sage Master Builder window. Your connection state is defined by several factors
involving your network connectivity and the availability of license uses. The
following table presents connection state definitions:

Sage license server con-
nection state

About Sage Master Builder win-
dow displays

Connected

You have launched Sage Master
Builder but not logged in to a com-
pany yet. Connected: License use
not acquired.

Connected
You have successfully logged in to
a company. Connected: License
use acquired.

Connected

After a successful login, you have
chosen to open a new company,
change user name/access, or
change the Sage license server.
Connected: License use returned.
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Sage license server con-
nection state

About Sage Master Builder win-
dow displays

Originally connected, later dis-
connected, now reconnected

You have successfully logged in,
but you lost connection to Sage
license server and the license use
has expired. Now you are con-
nected again but when you try to
acquire a license use, no uses are
available. Connected: License use
lost.

Disconnected

You are disconnected at launch or
at subsequent log in when select-
ing a company. Disconnected: x
uses remaining, or Disconnected:
One use remaining.

Connected
Your educational or trial product
has expired. Activated license has
expired.

Connected

Your unauthorized product has
expired. The seven-day grace
period for license activation has
expired.

NOTE: If the computer running the Sage license server
becomes disconnected from the other computers on your
network, or if your computer becomes disconnected from the
Sage license server, you may see an alert message from Sage
Master Builder telling you that you are disconnected.

Viewing the Sage license server connection state

You can view the current connection state of the Sage license server. This may
help you in situations where your Sage license server connection status is not
what you expect it to be. Viewing the connection state can help you troubleshoot
problems.

To view the Sage license server connection state:

1 From the Sage Master Builder main window, click [Help > About Sage Master Builder].
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2 The About Sage Master Builder window appears.

3 In the lower right of the window just above the Close button, look for Sage License
Server Connection State.

4 The text in the box displays the current connection state.

Company List window

About the Company List window

During installation, you have the option to install Sage Master Builder on a
specific local drive, such as C:, D:, etc. When you launch Sage Master Builder,
the first window that appears is Company List. From this window, you select the
location of company you want to open, then you select the company itself, and
click [OK].

For example, if you have installed Sage Master Builder and the Sample Company
on local drive C:, and this is the first time you have launched the program, then
the program displays the local drive, and the Sample Company appears in the list
directly below.

In most business situations, the company that you use to manage your business is
not located on your local computer; it is located on a server computer on your
local area network. The server could be a dedicated server in a client/server
configuration or it could be a colleague’s computer in the next office using a peer-
to-peer configuration.

In a network environment, clicking the drop-down arrow displays all the local
drives and all the network drives that you have access to. In the following
graphic, you can see a list of network drives that have been mapped to from this
computer.

If you can see the shared network drive in the list, then you can access the Sage
Master Builder company located on that drive.
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If you cannot see the drive where the company is located, then ask yourself these
questions or consult with your network administrator to locate your company.

Have you lost your network connection? If you have, then you cannot
access network drives and the Sage Master Builder company.

Has the server lost its network access or crashed? If that has happened, then
you can access the server and the company.

Has the company been moved to a different computer and drive? If that’s
true, then you have to map to the network drive in its new location.

Mapping a network drive to access a company

You may have to map to a network drive to access a Sage Master Builder
company if it is not located on a drive on your local computer. Let’s suppose that
the company has been moved to network drive Z: Now to access the company
data, you have to map to drive Z.

To map a network drive to access a company:

1 On your Windows desktop, click [Start > Explore].

2 On the tool bar, click [Tools > Map Network Drive].

3 On the Map Network Drive window, click [Browse].

4 Locate the drive, and then click [OK].

5 On the Map Network Drive window, click [Finish].

6 Launch Sage Master Builder.

7 On the Company List window, select drive Z.

8 Select the company, and click [OK].
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Special Configurations - Operating
Systems and Services
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Chapter 6: Special Configurations -
Operating Systems and Services

Windows 7 Professional and Server 2008 R2 Standard

Operating Systems

Launching Sage Master Builder to run as administrator for
scheduling reports

IMPORTANT: On computers runningWindows 7 Professional
or Server 2008 R2 Standard, scheduling SageMaster Builder
reports and viewingMy Scheduled Reports requires that you to
“run as administrator” or to “run the program as administrator.”

Microsoft Windows has changed security rules in the Windows 7 Professional
and Server 2008 R2 Standard operating systems to make your computer more
secure. If you are running Sage Master Builder as a typical user, then you have
limited privileges in some areas of the program, such as saving a report schedule
or viewing My Scheduled Reports. So, to save a report schedule or view My
Scheduled Reports, you must launch Sage Master Builder with the command to
either Run as administrator or Run this program as an administrator.

When you select either command, the settings are limited to you personally. Your
settings to run Sage Master Builder as administrator do not affect the next person
who logs on and launches Sage Master Builder from this computer. Your settings
on this computer can either be temporary or persistent. For example, when you
select Run as administrator, you run the program as administrator for that session
only. When you select Run this program as an administrator, you set program
properties to always run the program as administrator when you log on to this
computer.
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NOTE: "Run as administrator" and "Run this program as an
administrator" are not related to Windows 7 Professional or Server
2008 R2 Standard operating systems user groups but are limited
to a specific program you are running.

To set Run as administrator:

1 On your Windows desktop, right-click the Sage Master Builder program icon.

2 From the drop-down menu, to launch the program, click [Run as administrator].

NOTE: Selecting Run as administrator only runs the current session of running Sage Master
Builder. The setting does not persist.

To set Run this program as an administrator:

1 On your Windows desktop, right-click the Sage Master Builder program icon.

2 From the drop-down menu, click [Properties].

3 On the Sage Master Builder Properties window, click the [Compatibility] tab.

4 Under Privileges Level, select Run this program as an administrator.

5 Click [Apply], and then click [OK].

NOTE: Selecting Run this program as an administrator always runs the program with these
properties when you launch the program on this computer. The setting persists.

Windows 7 Professional and Server 2008 R2 Standard "Sleep
Mode" prevents computers from obtaining a license use

If a computer running the Windows 7 Professional or Server 2008 R2 Standard
operating system is used as a license server, when it goes into sleep mode other
computers on the network can’t obtain a license.

Set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never:”

1 Start > Control Panel > System and Security > Power Options.

2 Select Change when computer sleeps.
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3 From the Put computer to sleep list, select Never.
Sage licensing (Sage Service Host) cannot auto-start on
Windows 7 Professional and Server 2008 R2 Standard

The Sage licensing service (Sage Service Host) cannot auto-start on computers
running the Windows 7 Professional or Server 2008 R2 Standard operating
systems. If the service stops, the program displays a message advising you to take
further action to resolve this issue.

Solution for Server 2008 R2 error message about mb7.kpr file

If you encounter an error message about opening the mb7.kpr file when
launching Sage Master Builder on a computer running Windows Server 2008 R2,
follow these steps to resolve the issue:

1 On the Window desktop, right-click Start, and then click Open Windows Explorer.

2 On the left side of the window, under Computer > Local Disk, right-click the \MB7
folder, and then select Properties.

3 On the MB7 Properties window, click the Security tab.

4 From the list under Group or User Names, select USERS, then click the [Edit] button.

5 On the Permissions window, select USERS again, and under Allow, select the Full
control check box.
Selecting Full control, selects all the check boxes necessary for this solution.

6 On the Permissions window, click [OK], and then on the MB7 Properties window, click
[OK].

Server 2008 R2 network configuration and TCP Remoting
Channel

Sage Master Builder uses the TCP Remoting Channel, a Microsoft .NET
Framework component to enable communication among computers on a network.
File and printer sharing on computers running the Server 2008 R2 operating
system must be enabled. To enable file sharing, follow the instructions in the
Windows Server 2008 R2 Help.
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Windows Server 2008 R2 and Microsoft .NET 3.5.1

The Microsoft .NET 3.5.1 must be available and enabled on a Windows Server
2008 R2 machine.

To enable .NET 3.5.1 on Windows Server 2008 R2:

1 Click [Start] on the Server.

2 Click [Control Panel].

3 Under the Programs section, click on "Turn Windows Features On or Off."

4 Scroll down to the Features Summary section and select "Add Features."

5 Expand ".NET Framework 3.5.1 Features."

6 Check the box for ".NET Framework 3.5.1."

NOTE: Enabling .NET Framework 3.5.1 may require a reboot.

7 Restart Sage Master Builder.

Windows Vista, Windows 7, and Server 2008 Operating

Systems

Installation and AutoPlay

Program installations begin immediately upon inserting the CD into the CD-ROM
drive if AutoPlay is set to begin automatically. With computers running the
Windows XP operating system, you can start the installation manually by using
the Start > Run > Browse command to locate and select setup.exe. With
computers running the Vista and Server 2008 operating systems, this command
path has changed.
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On Vista/Windows 7, click the Vista/Windows 7 button (left circular but-
ton at lower left of the system tray) to open a window with the Start/Search
text box at the bottom. Type setup.exe in the text box, and press the Enter
key. When the system search locates the file on the CD, double-click the
file to begin the installation process.

On Server 2008, click Start > Run > Browse. Locate setup.exe, on the
CD, and double-click the file to start the installation.

Launching Sage Master Builder to run as administrator for
scheduling reports

IMPORTANT: On computers runningWindows 7 Professional
or Server 2008 R2 Standard, scheduling SageMaster Builder
reports and viewingMy Scheduled Reports requires that you to
“run as administrator” or to “run the program as administrator.”

Microsoft Windows has changed security rules in the Windows 7 Professional
and Server 2008 R2 Standard operating systems to make your computer more
secure. If you are running Sage Master Builder as a typical user, then you have
limited privileges in some areas of the program, such as saving a report schedule
or viewing My Scheduled Reports. So, to save a report schedule or view My
Scheduled Reports, you must launch Sage Master Builder with the command to
either Run as administrator or Run this program as an administrator.

When you select either command, the settings are limited to you personally. Your
settings to run Sage Master Builder as administrator do not affect the next person
who logs on and launches Sage Master Builder from this computer. Your settings
on this computer can either be temporary or persistent. For example, when you
select Run as administrator, you run the program as administrator for that session
only. When you select Run this program as an administrator, you set program
properties to always run the program as administrator when you log on to this
computer.
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NOTE: "Run as administrator" and "Run this program as an
administrator" are not related to Windows 7 Professional or Server
2008 R2 Standard operating systems user groups but are limited
to a specific program you are running.

To set Run as administrator:

1 On your Windows desktop, right-click the Sage Master Builder program icon.

2 From the drop-down menu, to launch the program, click [Run as administrator].

NOTE: Selecting Run as administrator only runs the current session of running Sage Master
Builder. The setting does not persist.

To set Run this program as an administrator:

1 On your Windows desktop, right-click the Sage Master Builder program icon.

2 From the drop-down menu, click [Properties].

3 On the Sage Master Builder Properties window, click the [Compatibility] tab.

4 Under Privileges Level, select Run this program as an administrator.

5 Click [Apply], and then click [OK].

NOTE: Selecting Run this program as an administrator always runs the program with these
properties when you launch the program on this computer. The setting persists.

Vista and Server 2008 “Sleep Mode” prevents computers from
obtaining a license use

If you are using a Vista or Server 2008 computer as the Sage license server and it
goes into Sleep Mode, the workstations cannot obtain a license use. Possible
resolutions are:

Use a different computer on your network to be the Sage license server. Any
supported operating system can be used in place of Vista or Server 2008, for
example, Windows XP.

Set Sleep Mode on your license server computer to Never.
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To set the Sleep Mode to Never:

1 Start > Control Panel > System and Maintenance > Power Options.

2 Select Change when computer sleeps.

3 From the Put computer to sleep list, select Never.
Sage licensing (Sage Service Host) cannot auto-start on Vista,
Windows 7, or Server 2008

IMPORTANT: Read this information if you are running
Vista or Server 2008 operating systems on your office
computers.

The Sage licensing service (Sage Service Host) cannot auto-start on computers
running the Vista, Windows 7, or Server 2008 operating systems. If the service
stops, the program displays a message advising you to take further action to
resolve this issue.

Solution for Server 2008 error message about mb7.kpr file

If you encounter an error message about opening the mb7.kpr file when
launching Sage Master Builder on a computer running Windows Server 2008,
follow these steps to resolve the issue:

1 On the Window desktop, right-click Start, and then click [Explore].

2 On the left side of the window, under Folders, right-click the MB7 folder, and then select
Properties.

3 On the MB7 Properties window, click the [Security] tab.

4 From the list under Group or User Names, select USERS, then click the [Edit] button.

5 On the Permissions window, select USERS again, and under Allow, select the Full
control check box.
Selecting Full control, selects all the check boxes necessary for this solution.

6 On the Permissions window, click [OK], and then on the MB7 Properties window, click
[OK].

Sage Master Builder
74 Chapter 6



Vista, Windows 7, and Server 2008, or Server 2008 R2
installation and mapped drives

Mapped drives may not be available when installing on a computer running the
Vista, Windows 7, or Server 2008 operating systems. See the Microsoft
knowledgebase article about allowing mapped drives to display elevated users:
http://support.microsoft.com/kb/937624/

NOTE: If you need to install to a mapped drive, install the
program to a computer that is running another supported
operating system, such as Windows XP.

Vista, Windows 7, and Server 2008 network configuration and
TCP Remoting Channel

Sage Master Builder uses the TCP Remoting Channel, a Microsoft .NET
Framework component to enable communication among computers on a network.
File sharing on computers running the Vista, Windows 7, or Server 2008
operating system must be enabled. To enable file sharing, follow the instructions
in the Vista, Windows 7, or Server 2008 Help.

Vista, Windows 7, and Server 2008 and changing the Sage
License Server computer

On a Vista, Windows 7, or Server 2008 workstation, when you select File >
Change Sage License Server > Select the computer from the list of
computers on your network, the command may fail to generate a list of network
computer names. To resolve this issue, click Enter the IP address or name of
the computer, and then type the IP Address of the server computer in the box.

Windows Server 2003 Operating System

NOTE: Configuration for Windows Small Business Server
2003 is the same as configuration for Windows Server 2003.
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Configuring Windows Server 2003 date format

It is necessary when using Windows Server 2003 to configure the date format.

To configure the Windows Server 2003 date format:

1 Click the [Start] button, point to Control Panel, then click Regional and Language
Options.

2 On the Regional and Language Options dialog box, on the Regional Options tab, click
the Customize... button.

3 On the Customize Regional Options dialog box, click the [Date] tab.

4 Under Short date, from the Short date format drop-down list, select MM/dd/yyyy.

5 Click [OK].

6 To close Customize Regional Options, click [OK] again.
Setting up Windows Server 2003 for PDF and RTF printers

In Windows Server 2003 (Standard Edition) and Windows Server 2003
(Enterprise Edition), the installation of kernel-mode drivers is blocked by default.
Before you can install Sage Master Builder PDF and RTF printers with Windows
2003 Server, you have to unblock the installation of the kernel-mode drivers and
edit the Group Policy.

To unblock the installation and edit the Group Policy:

1 On your Windows Server desktop, click [Start], then Run....

2 The Run dialog box opens.

3 In the Open: text box, type gpedit.msc, and then press Enter.

4 The Group Policy window opens.

5 In the left pane, on the Tree tab, double-click the Administrative Templates folder.

6 Then double-click the Printers folder.

7 In the right pane, in the Setting list, find and set the state of the setting for Disallow
installation of printers using kernel-mode drivers to Disable.
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Windows XP Professional (SP2) Operating System
Configuring the Windows XP Professional date format

To configure the date format:

1 Click the [Start] button, point to Settings, and click Control Panel.

2 Double-click the Regional and Language Options icon, and click the Regional Options
tab.

3 Click the Customize button and the Date tab.

4 In the Short Date Format list, select MM/dd/yyyy.

5 Click [OK].
Citrix and Terminal Servers
Using Citrix and Terminal Server with Sage Master Builder

Many people use Citrix and Terminal Server to manage remote access to their
local area network (LAN). If Sage Master Builder is installed on the computer
running Citrix or Terminal Server and on your laptop, then you may log on to the
computer running Citrix or Terminal Server with your laptop and work in Sage
Master Builder on your LAN. This enables you to work from home, from a job
site, or from any number of other remote locations.

We recommend that you use DOS commands to change the operating mode from
“execute” to “install” and then back to “execute.” When using the DOS
commands to install, you may install the Sage Master Builder software as you
would on any desktop or Windows server operating system that meets Sage
Master Builder requirements.

Installing on computers running Citrix and Terminal Server using
DOS commands

To install using DOS commands:

1 Click [Start], then Run.

2 On the Run window, in the Open drop-down box, type cmd, and press the Enter key.

3 The \Windows\...\cmd.exe window appears.
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4 At the prompt, type change user /install, and press the Enter key.

5 This enables the install mode.

6 Install the Sage Master Builder software as you would on a typical workstation or
Windows Server.

7 At the end of the installation process, choose to launch the License Administration Tool.

8 Using the License Administration Tool window, manage your license and activate it.

9 After activation, click [Start], then [Run].

On the Run window, in the Open drop-down box, type cmd, and press the Enter
key.

The \Windows\...\cmd.exe window appears.

At the prompt, type change user /execute.

This enables the execute mode, which is the default mode for running Citrix and
Terminal Server.

Exit the Run window.

Restart the server.

IMPORTANT: If this message appears: “Install mode does not apply to a terminal server
configured for remote administration,” then it is not necessary to enable the install mode.
Youmay install the SageMaster Builder software as you would on a typical workstation.

Backing Up Your Data

Data backup

With any computer system, there is the possibility for failure and loss of data.

Caution!

Use a backup method and device suitable for your business
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requirements. We strongly recommend that you maintain a
routine backup schedule and store your data in a safe
environment that is separate from your server, preferably off
site.

Which files to back up in Sage Master Builder

NOTE: This topic only applies to existing Sage Master Builder
customers.

When you back up your company data, we recommend that you back up your
company financial data as well as all your custom reports and forms. If you are
running multiple Sage Master Builder companies, back all of them up.

When backing up data as part of the year-end close process, it is important to
count the number of files and folders in your company.

To see the number of files and folder in a company folder, in Windows Explorer,
right-click the company folder and select Properties. On the Properties window,
the General tab, look in the list for the Contains line for the number of files and
folders. Write this number down so that you can refer to it after you have made
the two copies. The number of files and folders has to be exactly the same in both
the company and the backup copy.

IMPORTANT: If you are working across a network, youmust
remember to backup company folders, report folders, and form
folders that reside at the server.

We strongly recommend that you back up:

Each company folder that contains financial data (\MB7\your company\)

The Custom Reports folder (\MB7\Custom Reports)
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The Report Forms folder (\MB7\Report Forms)

The System Reports folder (\MB7\System Reports)

IMPORTANT: When backing up your data, be sure tomake a
full backup and not an incremental or differential backup. An
incremental or differential backup only records alterations to the
data since the last backup.

An example of one backup method

There are various methods for backing up your data. Depending on the amount of
data entry you routinely perform, you might consider making full daily backups.
It is also a good idea to regularly take one backup off the business premises or
store them in a fireproof safe. If a burglary or fire occurs, a copy of your data is
safe from harm.

One reliable procedure, requiring a tape drive and multiple sets of tapes, requires
you to make daily and monthly backups.

Daily Backup Process

For the daily backup process, you need 10 tapes. Label five of the tapes as Week
A, with a tape designated for each weekday. Label the other five tapes as Week
B, with a tape designated for each weekday.

Start with the set of tapes labeled Week A. Monday night when you make the
backup use the tape labeled Monday, on Tuesday use the tape labeled Tuesday,
and so forth. At the start of the next week, use the set of tapes labeled Week B to
make your backups. At the end of two weeks, you will have a data backup for
each day. Then at the start of the third week, use the set of tapes labeled Week A
again. Over the course of a year, you will cycle through the two sets of tapes. Be
sure to store the most recent Friday backup off site.
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Monthly Backup Process

For the monthly backups, you need a separate set of three tapes labeled Month A,
Month B, and Month C respectively. Like the weekly backups, use each tape to
back up the data for a different month, cycling through each of the tapes over the
course of the year. After making a monthly backup, write the month and year on
the label to help you track which tape to use next. Be sure to remove the most
recent monthly backup off site.

Backing up your data to a CD or DVD

This topic suggests a generic way to back up your data to a CD or DVD.
Backing up to a CD or DVD successfully depends on your computer system,
including hardware and software. To back up to a CD or DVD, you must have
access to a CD or DVD (Read/ Write capability), and the appropriate CD or
DVD media.

When backing up data as part of the year-end close process, it is important to
count the number of files and folders in your company. To see the number of files
and folder in a company folder, in Windows Explorer, right-click the company
folder and select Properties. On the Properties window, the General tab, look in
the list for the Contains line for the number of files and folders. Write this number
down so that you can refer to it after you have made the two copies. The number
of files and folders have to be exactly the same in both the company and the
backup copy.

IMPORTANT: If you are working across a network, youmust remember to backup
company folders, report folders, and form folders that reside at the server.

To back up your data to a CD or DVD:

1 Place the CD or DVD media in the CD or DVD.

2 On your Windows desktop, right-click [Start > Explore].

3 In Windows Explorer, locate the \MB7\ folder again, right-click the [Custom Reports]
folder and from the menu select [Copy].

4 Locate the CD or DVD drive, and click it.
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5 Then in the right-pane, right-click and select [Paste].

6 In Windows Explorer, locate the \MB7\ folder again, right-click the [Report Forms]
folder and from the menu select [Copy].

7 Locate the CD or DVD drive, and click it.

8 Then in the right-pane, right-click and select [Paste].

9 In Windows Explorer, locate the \MB7\ folder again, right-click the [System Reports]
folder and from the menu select [Copy].

Locate the CD or DVD drive, and click it.

Then in the right-pane, right-click and select [Paste].

In Windows Explorer, locate the \MB7 folder.

Right-click a company folder that contains current financial data, and from the
menu, select [Copy].

Locate the CD or DVD drive, and click it.

Then in the right-pane, right-click and select [Paste].

Repeat 12 through 15 for every active company with current financial data.

Depending on your hardware and software, the folder will be copied to the CD or
DVD media. For further information or support, contact your CD or DVD
 manufacturer.
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